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Technology for Everyone . . .*

Making Presentations Visual**

Diane Murley***

Ms. Murley discusses some PowerPoint problems and suggested solutions, 
describes some tips for using PowerPoint more effectively, and provides a list 
of sources.

¶1 In May 2001, The New Yorker observed that “there are great tracts of corporate 
America where to appear at a meeting without PowerPoint would be unwelcome 
and vaguely pretentious, like wearing no shoes.”1 Despite, or maybe because of, its 
ubiquity, PowerPoint has been criticized,2 ridiculed,3 and sometimes even banned.4 
But PowerPoint, used well, can be a powerful visual aid to communication. 

¶2 Whether you work in “corporate America” or in some other type of organiza-
tion, you have probably seen PowerPoint used effectively and ineffectively. And you 
have probably wondered how you could use it better. In this article, I will explore 
some of the ways to use PowerPoint better. Most of my tips and suggestions can also 
be applied to WordPerfect’s Presentations and other similar software.

PowerPoint Problems and Solutions

¶3 Criticisms of PowerPoint generally fall into three categories: (1) PowerPoint 
templates adversely affect how we think and communicate, breaking informa-
tion down into a linear series of bulleted lists; (2) PowerPoint slides cannot hold 
enough information for a serious discussion; and (3) PowerPoint presentations are 
boring. All of these problems can be avoided if we treat PowerPoint as a visual aid 
that can enhance a presentation, rather than as the presentation itself. 
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¶4 I have synthesized the following suggested solutions to these problems pri-
marily from three books: The Lawyer’s Guide to Creating Persuasive Computer 
Presentations;5 PowerPoint 2002 for Litigators;6 and Beyond Bullet Points: Using 
Microsoft PowerPoint to Create Presentations That Inform, Motivate, and Inspire.7 
Any of these books would be a good starting point for someone interested in 
improving their PowerPoint technique.

Solution #1: Don’t Use PowerPoint

¶5 Think of PowerPoint as a visual aid. Unless you work for an organization that 
requires the use of PowerPoint, do not use it unless you have a reason to do so. Law 
librarians make presentations of many kinds of information to a variety of audi-
ences. For some presentations, projected visuals, to which the speaker can direct 
the audience’s attention, help the communication process. But some presentations 
are not improved by projected slides and, in a worst case scenario, PowerPoint can 
even become a barrier to communication between the speaker and the audience.

¶6 PowerPoint is not always the best tool for the job. If another medium would 
help you communicate the information better, use it. If your presentation would 
benefit from a nonlinear approach, consider mind-mapping.8 If you need to present 
a large quantity of data, a written report or a non-PowerPoint handout may be bet-
ter.9 Finally, if you do not have anything that needs to be projected in order for the 
audience to understand your presentation, just talk to the people. Whatever your 
situation, choose the tool or tools that will enable you to communicate best with 
your audience. Use PowerPoint only when you have a reason to do so.10

Solution #2: Don’t Use Preset Design Templates

¶7 Microsoft PowerPoint comes loaded with dozens of built-in templates, anima-
tion schemes, clip art, and other features, and you can download even more online. 
With the exception of the layout templates and color schemes, you should avoid 
using these features.11 The slide-design templates and clip art take up valuable 
space on the slides without adding anything to your presentation.12 Worse, the 
background themes and unnecessary graphics are likely to be recognizable, a dis-
traction, or even an annoyance for audience members.13 

	 5.	 Ann E. Brenden & John D. Goodhue, The Lawyer’s Guide to Creating Persuasive Computer 
Presentations (2d ed. 2005).

	 6.	 Deanne C. Siemer & Frank D. Rothschild, PowerPoint 2002 for Litigators (2d ed. 2002).
	 7.	 Cliff Atkinson, Beyond Bullet Points: Using Microsoft PowerPoint to Create Presentations 

That Inform, Motivate, and Inspire (2005).
	 8.	 For more information on mind mapping, see Diane Murley, Mind Mapping Complex Information, 99 

Law Libr. J. 175, 2007 Law Libr. J. 11.
	 9.	 See Tufte, supra note 2, at 22, 24.
	 10.	 See generally Walt Crawford, First Have Something to Say: Writing for the Library 

Profession 119–22 (2003); Tufte, supra note 2, at 24.
	 11.	 Brenden & Goodhue, supra note 5, at 160, 183 n.7.
	 12.	 See Tufte, supra note 2, at 12.
	 13.	 Atkinson, supra note 7, at 213–14.
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¶8 When you make formatting choices, you should take into account the type 
of presentation you will be making and where your slides will be displayed. A solid 
dark background works well for slides on which you will display a variety of con-
tent, such as scanned documents, photos, and screen shots. A dark background is 
also preferable when the slides will be displayed on a large screen, because lighter 
colors tend to wash out. If you have slides on which you will display text, make 
the fill color of the text box white or a very light color, and make the text black, in 
a clean sans serif font. Putting a thin, dark line around text boxes and other content 
gives them a nice, sharp delineation, even against a dark background.14 

Solution #3: Eliminate or Minimize Special Effects

¶9 One of the easiest ways to make your PowerPoint presentations look less than 
professional is to use too many special effects.15 Used excessively, they take the 
focus off your content, lose their impact, and turn off your audience.16 Control 
animation effects by using the Custom Animation functionality;17 avoid the built-in 
animation schemes.18

¶10 As a general rule, use animation and slide transitions conservatively and 
only when you can articulate a specific reason for doing so.19 For instance, if you 
use a bullet-point slide to guide the audience through part of your presentation, use 
Custom Animation to control when each point appears. By revealing each point 
separately, you can keep everyone focused on the same point and avoid tempting 
the audience to read ahead.20 Use Effect Options to dim each point as the next one 
appears, thereby emphasizing the point being discussed, while leaving previous 
points visible to help the audience put each new one into context.21 You can also 
use Custom Animation to gradually reveal diagrams and charts.22

¶11 Besides using Custom Animation to control entrances, you can also use 
it to specify when an item will exit or disappear from the slide. By combining 
entrance and exit effects, you can replace objects on the screen.23 For example, 
as you reveal each point in a bulleted list, you can replace the image used to 
illustrate the previous point with an image that illustrates the new point. By 
duplicating slides, you can create a similar effect using multiple slides instead 
of animation effects.24

	 14.	 See Siemer & Rothschild, supra note 6, at 112–17.
	 15.	 Larry Bodine, Slick Slides, 30 Law Prac., Nov./Dec. 2004, at 53, 53.
	 16.	 Dennis Kennedy, Ten Tips to Improve Your Presentations with PowerPoint ¶¶ 2, 4, Dennis Kennedy.

com, http://www.denniskennedy.com/products/free‑samples/pptips.aspx (last visited Dec. 28, 2006).
	 17.	 Brenden & Goodhue, supra note 5, at 191.
	 18.	 Id. at 183 n.7.
	 19.	 Siemer & Rothschild, supra note 6, at 125–29, 537.
	 20.	 Brenden & Goodhue, supra note 5, at 187–88.
	 21.	 Siemer & Rothschild, supra note 6, at 138–40.
	 22.	 See, e.g., id. at 385–87. For examples of animated diagrams and charts created using multiple slides 

instead of PowerPoint animation effects, see Atkinson, supra note 7, at 159–67.
	 23.	 See Brenden & Goodhue, supra note 5, at 201.
	 24.	 See Atkinson, supra note 7, at 170, 174–75.
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Solution #4: Reduce the Amount of Text That You Project

¶12 PowerPoint makes it easy to create bullet-point slides, but that is a weak use of 
the medium.25 One communications coach and author referred to a series of bul-
let-point slides as “dull, mind‑numbing, and monotonous.”26 He advises speakers 
to limit their use of slides with bullet points. “It’s perfectly fine to have bullets, 
perhaps alongside a graphic. But two slides of bullets back to back (let alone sev-
eral) can be deadly.”27

¶13 In all the books, articles, and blog entries that I have read about improving 
PowerPoint presentations, the most common tip is a formula designed to reduce 
the amount of text in a presentation. Some tips focus on reducing the amount of 
text per slide: 

	 l	 “Maximum words in a line: 6. Maximum lines in a slide: 6.”28

	 l	 “[F]our to six evenly spaced one‑line statements.”29

	 l	 “Limit your points on a slide to 3 to 6 points. Avoid sub‑headings.”30

	 l	 “No more than six words on a slide. EVER.”31 

Others focus on the number of slides:

	 l	 “[A] PowerPoint presentation should have ten slides, last no more than twenty 
minutes, and contain no font smaller than thirty points.”32

	 l	 “15 minutes with one slide in the background. . . . [A] total of 11 slides for a 
one hour presentation. . . . 15 in an hour. . . . [A] total of only five slides in two 
hours!”33

¶14 Edit your PowerPoint slides ruthlessly. Eliminate all extraneous words, 
leaving only the bare minimum necessary34 to help the audience focus on the 
essential points of your presentation.35 If you will spend some time discussing a 
particular question or statement, projecting a slide containing just that question 
or statement will help the audience follow the discussion,36 but you should be 
careful not to overcrowd the slide with text.37 Concise bulleted lists can provide 

	 25.	 Mark Tamminga, Peter Bensinger, Jr. Q&A, Law Prac., Jan./Feb. 2006., at 26, 27.
	 26.	 Carmine Gallo, How to PowerPoint Like a Pro, Business Week Online, June 2, 2006, http://www	

.businessweek.com/smallbiz/content/jun2006/sb20060602_100148.htm.
	 27.	 Id.
	 28.	 Bodine, supra note 15, at 53.
	 29.	 Siemer & Rothschild, supra note 6, at 79.
	 30.	 Kennedy, supra note 16, ¶ 2.
	 31.	 Seth Godin, Really Bad PowerPoint (and How to Avoid It) 7 (2001), available at http://www	

.sethgodin.com/freeprize/reallybad‑1.pdf.
	 32.	 Guy Kawasaki, The 10/20/30 Rule of PowerPoint, How to Change the World, Dec. 30, 2005, 

http://blog.guykawasaki.com/2005/12/the_102030_rule.html.
	 33.	 Gallo, supra note 26.
	 34.	 Siemer & Rothschild, supra note 6, at 79.
	 35.	 Richard E. Mayer & Roxana Moreno, Nine Ways to Reduce Cognitive Load in Multimedia 

Learning, 38 Educ. Psychologist 43, 48 (2003).
	 36.	 Jennifer Jolly‑Ryan, Disabilities to Exceptional Abilities: Law Students with Disabilities, 

Nontraditional Learners, and the Law Teacher as a Learner, 6 Nev. L.J. 116, 144–145 (2005).
	 37.	 Kennedy, supra note 16, ¶ 2.
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an overview to your presentation and establish connections between parts of your 
presentation,38 but they should be used sparingly.39

¶15 When you start to create a new PowerPoint presentation, choose font sizes 
for the title and text boxes that are appropriate to the size of the room in which you 
will make your presentation and the equipment you will use.40 Set those font sizes 
as the defaults in the Slide Master and stick with them. Just as word limits force 
writers to write concisely, appropriate default font sizes can help you to create bet-
ter PowerPoint slides by forcing you to include only necessary words.41

¶16 Nobody attends a presentation to read the speaker’s notes, but that is 
frequently what happens. Too many speakers duplicate their notes as bullet-point 
slides. When slides have too much text, audience members must split their atten-
tion between the speaker’s words and those on the slides. Or worse, if the size of 
the text is too small to read from where they are sitting, members of the audience 
will become frustrated.42 Slides with too much text do not help you communicate 
with your audience.

The Beyond Bullet Points Approach

¶17 Many attorneys who create highly visual PowerPoint presentations recommend 
Cliff Atkinson’s Beyond Bullet Points: Using Microsoft PowerPoint to Create 
Presentations That Inform, Motivate, and Inspire.43 The Beyond Bullet Points 
(BBP) approach will not work for every presentation, but the book is worth reading 
if you are interested in making your presentations more visual. Some of the BBP 
techniques can be used for any presentation, and many of Atkinson’s ideas could 
be applied to individual slides or parts of a presentation.

¶18 I don’t have the space here to explain the BBP approach in detail, but this 
overview should give you a sense of the process. BBP is based on a combination 
of the principles of Hollywood filmmaking, classical storytelling, and multimedia 
learning.44 Beginning with a Microsoft Word template (available for download at 
www.sociablemedia.com), the book guides you through creation of a three-act 
story,45 which you then send to PowerPoint for creation of a storyboard. Using a 
PowerPoint template (available for download at www.sociablemedia.com), you 
convert the story to a storyboard.46

¶19 All words other than the headline are placed in the notes area.47 Each slide 
will eventually consist of a single complete-sentence headline and a full-screen 

	 38.	 Jolly-Ryan, supra note 36, at 144.
	 39.	 Gallo, supra note 26.
	 40.	 For suggested font sizes, see Siemer & Rothschild, supra note 6, at 100.
	 41.	 Kawasaki, supra note 32; see also Atkinson, supra note 7, at 86.
	 42.	 See Danelle Hall, A View from the Back Row, Am. Libr., May 2002, at 64, 64–65.
	 43.	 Atkinson, supra note 7.
	 44.	 Id. at 10–12.
	 45.	 Id. at 21–76.
	 46.	 Id. at 77–112.
	 47.	 Id. at 93–98.
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photograph or other illustration.48 The speaker will use spoken words and projected 
visuals to tell a story.49 The author recommends printing and handing out notes 
pages, rather than the usual PowerPoint handouts.50 To prevent the distraction of 
the audience reading these materials instead of listening to the speaker, Atkinson 
recommends that they be distributed after the presentation.51 If a pre-presentation 
handout is necessary, he suggests a one-page version of the story template.52

PowerPoint Tips and Tricks

¶20 Now that I have covered PowerPoint features you should avoid, let me tell you 
about some useful features that you might not know about. In addition to the books 
listed above, Siemer and Rothschild’s PowerPoint 2003: 50 Great Tips for Better, 
Easier Slides53 is a good source for more suggestions.

Formatting the Slide Master or Creating a Template

¶21 Rather than using a slide-design template, start with a blank presentation. 
Designing your own slides is not difficult, and you will be happier with the results. 
Set up the Slide Master—default formats for all the slides in the presentation—by 
choosing Master, then Slide Master from the View menu. Format the background 
color of the slide, the background (fill) and border (line) of the text and content 
boxes, and the fonts by choosing Background, Placeholder, and Fonts, respec-
tively, from the Format menu. Delete the Date Area, Footer Area, and Number 
Area boxes by clicking on their borders and pressing the Delete key. Resize the 
remaining boxes, using the handles in the middle of each side and on each corner, 
to maximize the available space on the slide. Close the Master View.54

¶22 You have just designed your first PowerPoint presentation. If you want to 
use this design again, save it as a Design Template (*.pot) with a file name and in 
a subdirectory that you will remember.55 You can change the Slide Master formats 
for individual slides, but it is better to stick with a consistent format for visual 
continuity.56

Toolbars

¶23 Exploring the toolbars is a good way to discover some of PowerPoint’s fea-
tures. Activate the toolbars from the View menu. PowerPoint 2002 for Litigators 

	 48.	 Id. at 113–80.
	 49.	 Id. at 114–17.
	 50.	 Id. at 116. For an example of this type of handout, see Cliff Atkinson & Richard E. Mayer, Five 

Ways to Reduce PowerPoint Overload 14 (2004), available at http://www.sociablemedia.com/
PDF/atkinson_mayer_powerpoint_4_23_04.pdf.

	 51.	 Atkinson, supra note 7, at 196.
	 52.	 Id. at 197.
	 53.	 Deanne C. Siemer & Frank D. Rothschild, PowerPoint 2003: 50 Great Tips for Better, Easier 

Slides (2005).
	 54.	 See Siemer & Rothschild, supra note 6, at 61–64, 159–60; Atkinson, supra note 7, at 82–83.
	 55.	 See Atkinson, supra note 7, at 109–10. 
	 56.	 Siemer & Rothschild, supra note 6, at 100; Atkinson, supra note 7, at 144.
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has a good overview of the toolbars and buttons that you are most likely to use.57 
I will point out just a few of my favorites here.

¶24 Use buttons on the drawing toolbar to add lines, arrows, rectangles, ovals, 
autoshapes, text boxes, pictures, diagrams, and more. Once you have inserted one 
of these objects, activate it by clicking on it (for text boxes, click on the border). 
You can drag the object to a different location, use the arrow keys to move it by 
small increments, or use the Ctrl key plus an arrow key to move it a pixel at a 
time.58 Activate Guides, Grids, and Ruler bars from the View menu for precise 
positioning and centering.59

¶25 Activate more than one object by holding down the shift key while click-
ing on each of them. Using the Draw button, align the objects left, center, or right, 
and top, middle, or bottom.60 Distribute them horizontally or vertically for even 
spacing.61 If you have overlapping objects, such as a title box and a full-screen 
picture, use Order on the Draw menu to bring individual items forward or send 
them backward.62

Slide-Show Tools

¶26 While you are presenting, you may want to blank the screen to avoid distract-
ing the audience while you discuss something not covered by a slide. If you know 
in advance that you will want to blank the screen, you can insert a blank slide into 
your presentation. During the presentation, while you are in Slide Show view, press 
the “B” key to go to a black screen or the “W” key to go to a white screen.63 The 
escape key will take you back to where you were before you blanked the screen.

¶27 You may want to highlight or mark an image or document you are projecting. 
If you know in advance that you will want to emphasize something on a slide, you 
can insert a rectangle or oval, in any color with a transparent fill, and use Custom 
Animation to have it appear after the rest of the slide.64 If you need to add emphasis 
during the presentation, right-click on the slide and choose Pointer Options, then 
Ballpoint Pen, Felt Tip Pen, or Highlighter.65 Your choice of pointer option will 
remain until you press the escape key. You won’t be able to use a mouse click to 
advance the presentation while the pointer is set to pen or highlighter, but the space 
bar, Enter key, and other keyboard shortcuts will work. When you exit Slide Show 
view, you will be asked whether to Keep or Discard your ink annotations.66

	 57.	 Siemer & Rothschild, supra note 6, at 22–30.
	 58.	 Id. at 70–71, 222.
	 59.	 Id. at 38–41.
	 60.	 Id. at 443–44.
	 61.	 Id.
	 62.	 Id. at 347.
	 63.	 Timothy Piganelli, Top 10 Hidden Features of PowerPoint for Litigators ¶ 8, TechnoFeature, 

Aug. 22, 2006, reprinted in Posting of Sara Skiff to TechnoLawyer Blog, http://blog.technolawyer.
com/2006/10/top_10_hidden_f.html (Oct. 3, 2006).

	 64.	 See Siemer & Rothschild, supra note 6, at 270–76, 304–13.
	 65.	 Piganelli, supra note 63, ¶ 9.
	 66.	 Id.
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¶28 Sometimes during a presentation, you may want to jump to a specific 
slide. If you know the slide number, you can jump directly to that slide rather than 
advancing slide by slide. Simply press the Alt key, then the slide number, and hit 
Enter.67 On some computers, you don’t need the Alt key.68 Alternatively, right click 
on the current slide and choose Go to Slide to choose from a list of slide numbers 
and titles, if any.69 If you need to jump to the last slide, use the End key; to go to 
the first slide, use the Home key.70

¶29 Other commands to know:

	 l	 To go back, use the backspace key.71

	 l	 To keep your computer screen from going blank during your presentation, 
click on the Windows Start button and select Control Panel, then Power 
Options. Under Power Schemes, select Presentation.72

	 l	 When your computer is connected to a projector, you can toggle the display 
between your computer screen, the projector’s screen, or both. To toggle 
between the display options, hold down the Fn key while pressing the F8 key. 
(Sometimes it will be another F# key. Look for the key marked CRT/LCD or 
with a symbol to represent screen displays.)73

For More Inspiration

¶30 In this article, I have been able to present just a sampling of what you can do 
with PowerPoint. Besides the books listed earlier, which cover features a lawyer is 
likely to use, you can learn more from a general PowerPoint manual or Microsoft’s 
help screens. If you want ideas for taking a more visual approach to presentations, 
try some of the following:

	 l	 Presentation Zen (www.presentationzen.com). This blog by Garr Reynolds, 
about “issues related to professional presentation design,” provides thoughtful 
commentary and beautiful examples of visual presentation styles.

	 l	 Understanding Comics: The Invisible Art.74 Although not about PowerPoint, 
this book is frequently cited by proponents of visual presentations. The discus-
sion of how comics combine words and pictures to tell a story applies in many 
ways to what a good PowerPoint presentation can do.

	 l	 Dennis Kennedy and Tom Mighell, “Powerful Pointers for Presenters.”75 This 
annotated list of Web resources on PowerPoint and presentations in general 

	 67.	 Dan Pinnington, Tips & Tricks, How to Navigate PowerPoint Slides Like a Pro, Law Prac., Apr./May 
2006, at 26, 26.

	 68.	 Piganelli, supra note 63, ¶ 7.
	 69.	 Id.; Pinnington, supra note 67, at 26.
	 70.	 Pinnington, supra note 67, at 26–27.
	 71.	 Id. at 26.
	 72.	 Id. at 27.
	 73.	 Id.; Siemer & Rothschild, supra note 6, at 632–33.
	 74.	 Scott McCloud, Understanding Comics: The Invisible Art (1994).
	 75.	 Dennis Kennedy & Tom Mighell, Powerful Pointers for Presenters, Law Prac. Today, Aug. 2005, 

available at http://www.abanet.org/lpm/lpt/articles/slc08051.html.
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was prepared with lawyers in mind, but most of the resources are just as useful 
for law librarians.

	 l	 An Inconvenient Truth.76 The presentation slides that Al Gore uses in this docu-
mentary film provide a good example of a very visual presentation that relies 
primarily on spoken words and projected visuals.

	 l	 Berring on Legal Research: Deep Principles for Researching and Understanding 
the Law.77 In this instructional DVD, Bob Berring makes a very effective pre-
sentation with only a few screen shots and bulleted lists. 

Conclusion

¶31 Although complaints about some uses of PowerPoint are well founded, it can 
be an effective communication tool if used as a visual aid, rather than as a substi-
tute for speaker notes or a written report. I hope the tips and suggestions in this 
article will help you make your presentations more interesting and persuasive. A 
good PowerPoint presentation takes a little more effort than a bad one, but your 
audience will appreciate the results.

	 76.	 An Inconvenient Truth (Paramount Classics & Participant Productions 2006).
	 77.	 Robert C. Berring, Jr., Berring on Legal Research: Deep Principles for Researching and 

Understanding the Law (Thomson/West 2006).




